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I. Introduction 
Nova Scotia Community College (NSCC) is committed to offering a 
comprehensive continuum of service delivery.  This means that courses are 
offered in a number of different formats including face-to-face, part-time, online, 
and through a combination of blended formats.   
 
Computers are machines that have changed the way we do a lot of different 
things. In today’s world, a desktop computer is sometimes called a "PC." This 
stands for personal computer and is a term devised by IBM to describe their first 
desk top computer. In a nutshell, a computer functions like a gigantic calculator 
not only adding and subtracting numbers but also displaying and manipulating 
text and graphics.  
 
All members of the NSCC community must abide by the Nova Scotia Community 
College Computer Resources Usage Policy.  Make sure that you take the time to 
review this policy - it is available online at 
http://www.nscc.ca/it/policies/computer_usage_policy.asp
 
This package is intended to provide you with basic information to help you 
become more familiar with using computers.  
 
 

II. Parts of a Computer 

http://www.nscc.ca/it/policies/computer_usage_policy.asp
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Every computer system has both hardware and software. Hardware physically 
does the work: it is the physical components you can see and touch. Software 
tells the hardware how to do the work it has to do. Software is the brains or set of 
instructions that tell the hardware what to do and how to do it. By understanding 
a little bit about the hardware and software of computers, you will have a better 
appreciation of what is happening when you are using a computer, and how to 
proceed if things start to go wrong.  Listed below are brief explanations 
concerning the computer hardware components you will most likely encounter. 
 
A. Console  
 

 
The console is the box or case that holds the main parts of the computer. Some 
computer consoles are upright towers that stand on the floor or on the desk, 
others are horizontal and sit in a more flattened position.  This part of the 
computer houses the internal components that make it run. These components 
function in the processing and storing of information.  
 
Information can be stored in a temporary storage location called memory or 
"RAM." This type of storage is for information that the computer currently needs 
or has just processed. Information can also be stored in a more permanent way 
on disks. There is a hard disk enclosed in the console of the computer. This hard 
disk can have a wide range of storage capacity depending on the type of the 
computer.  
 
The back of the computer console has a number of outlets called ports. The 
cables from various other hardware components connect to the computer 
through these ports. Some of the ports are reserved for specific components, 
other ports can be used by different hardware components.  
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B. Keyboard 
 

 
The keyboard has keys like a typewriter and a number keypad like an adding 
machine. The keyboard is used to input data into the computer. You do not need 
to be a professional typist to be able to use a computer keyboard. Many people 
use the "hunt and peck" method of using the keyboard to type in information.  
 
At first glance, the typewriter keyboard and the computer keyboard appear to be 
quite similar. However, there are some basic differences between the two. 
Essentially, both are used to input letters, numbers and punctuation. Both have a 
tab key, a caps lock key and a shift key. With the computer, however, some of 
these similar keys have different functions. For example, besides allowing 
indenting, the tab key also allows you to move to different parts of the screen. 
Unlike the typewriter, the caps lock key does not affect the numbers or the 
punctuation keys, whereas depressing the shift key will reverse the case of the 
letters but will always display the special characters above the numbers. The 
“enter” button on the computer keyboard is analogous to the carriage return on 
the typewriter. The “enter” key is often used to respond to a question the 
computer gives you and is used to create a new line.  
 
On the computer keyboard there is often a numeric keypad similar to a 
calculator. This number pad only works when the "num lock" key is pressed and 
the corresponding green light on the top right side of the computer keyboard is 
on. When the "num lock" key is on, this pad can be used for numbers.  However, 
when the key is off, the arrow and word functions on each become active.  
 
There are other keys on a computer keyboard that you would not find on a 
typewriter. This includes the insert key, the delete key, the home and end key as 
well as the page up and page down keys. Along the top of the computer 
keyboard there are a number of extra keys called function keys. These keys are 
known as shortcut keys and are used to replace a series of key presses or steps. 
Function keys vary in what they actually do from application to application. Other 
keys such as the <cntrl> and <alt> keys were invented to help out with additional 
computer functions or tasks. They have various uses and applications when used 
in combination with other key presses at the same time.  
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C. Mouse 
 

The mouse is the small box with a thin cord (a tail) on the desk beside your 
console. When you move your mouse it sends a signal through the cord to the 
computer, telling the computer which direction the mouse is moving. This 
controls the movement of the small arrow (mouse cursor) on the screen. The 
mouse and the keyboard are similar in that they both allow you to tell your 
computer what to do. You can learn more about how to use a mouse in the 
section of this document entitled “Using The Mouse.” 
 
D. Disk Drive 

 
The Disk Drive is an information storage device. The computer stores information 
on disks like the VCR records onto videotape. The disk is the videotape, and the 
disk drive is your computer’s VCR. Disk drives contain a motor that spins the 
disk. The "head" hovers over the spinning disk, reading or writing information to 
or from the disk. The disk drive translates the stuff on the disk into information 
that the computer can use.  The computer hard disk, a CD-ROM disk and a 
floppy disk are some of the different types of disks.  
 
E. Printer 
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The printer is a separate device from the computer and it prints information on 
paper. The printer is capable of taking information stored in the computer and 
printing it in paper format (also called a hard copy). It is important that you ensure 
that your printer is turned on before you use it. However, some have no power 
switch, instead the printer becomes active when a print job is sent through the 
computer.  
 
F. Monitor 

 
The monitor is the television-like display unit sitting on top of the computer 
console.  Monitors can come in different sizes (some are much bigger than 
others). As well, some have different quality outputs, some are color whereas 
others are black and white.  
 
G. Other Components 
Computers may have a number of different peripheral pieces of hardware that 
help to accomplish different tasks.  Be aware that the computer you are using 
may have other parts than what has been listed here.    
 
 

III. Computer Software 
The software is what tells your hardware what to do and how to do it. On the 
market today, there are many different types of software.  Software can be 
categorized into two types: system software and application software. 
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System software is the operating system that enables the computer to function. 
Operating systems perform basic tasks, such as recognizing input from the 
keyboard, sending output to the display screen, keeping track of files and 
directories on the disk, and controlling devices such as disk drives and printers. 
 
Application software are programs that do the real work for users. For example, 
word processors (Microsoft Word), spreadsheets (Microsoft Excel) and database 
management systems (Microsoft Access) fall under the category of applications 
software. 
 
 

IV. The Windows Environment 
NSCC has Microsoft software licensing.  This means that Microsoft Windows is 
used as the system software for most computers on NSCC Campuses.  Windows 
is an operating system that uses icons. It’s called Windows because it fills the 
screen with overlapping windows or boxes. Each window contains its own 
program. In many ways, Windows makes it easier to use a computer. A lot of 
things can be accomplished by using a mouse instead of typing at the keyboard.   
 

A. What Is the Desktop? 
When you start a computer using Windows, the desktop is the area that first 
appears on the screen after you start. The desktop is your workspace. On your 
desktop are icons, small pictures that represent files such as documents, folders, 
or programs. When you want to open a file, double-click its icon. 
 
Note: Depending on how your computer is set up, your icons might be different 
from those in the illustration. 
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B. The Taskbar and the Start Button 
You can use the taskbar and the Start button, which usually appear at the bottom 
of your screen, to navigate in Windows.  Both features are always available on 
your desktop, regardless of how many windows you have open.   Buttons on the 
taskbar show you which windows and programs are open, even when some are 
minimized or hidden beneath another window. You can easily switch to a 
different window or program by clicking its taskbar button. 
 

 
The Start button displays a list of commands and shortcuts (pointers to files) that 
you can use to accomplish almost any task. You can start programs, open 
documents, customize your system, get Help, search for items on your computer, 
and more. Some items on the Start menu have a right-facing arrow, which means 
that additional choices are available on a secondary menu, called a submenu. 
When you place your pointer over an item with an arrow, a submenu appears. 
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C. My Computer 
Use the "My Computer" icon when you want to view the contents of a single 
folder or disk. A disk is a device, such as a hard drive or floppy disk, on which 
you can store files. When you double-click My Computer on your desktop, icons 
representing the available drives appear in a new window. When you double-
click a drive icon, a window displays the folders contained on that drive. You can 
then double-click an icon to open the folder or file. 
 
Some of the following icons may appear in the My Computer window: 

Double-Click 
 
In Order To… 

 
View the contents of the floppy disk, which is usually designated as A drive. 

 
View the contents of the hard drive, which is usually designated as C drive. 

 

View the contents of a network drive, if your computer is connected to one. 

 

View the contents of a compact disc in the CD-ROM drive, if your computer 
has one. 

 
View the contents of a removable disc, such as a zip drive, if your computer 
has one. 

 

View features in the control panel that you can use to modify your computer 
settings 

 
You will see when you open "My Computer" that the files on every computer are 
organized using a number of different folders.  This is kind of like the folders in a 



Online Learning: Using Computers  
 

filing cabinet.  They help to arrange and organize the information.  The goal is to 
make it easier to find information that you want and need.   
 
Most computers will have a default "My documents" folder where you can save 
your personal files.  If you are using a public access machine you may need to 
save your files to a portable floppy disk that you can take with you when you 
leave.   
 
 

D. Starting and Quitting Programs 
Most of the programs installed on your computer are available from one 
convenient location - the Programs section of the Start menu. Depending on how 
your computer is set up, what you see on the Start menu varies. 
 
To start a program 

1. Click the Start button, and then point to Programs.  The Programs 
menu appears. 

 
2. Point to the group (such as Accessories) that contains the program you 

want to start and then click the program name.  
 
To quit a program 
Click the Close button in the upper-right corner of the program window. 
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E. Shutting Down Your Computer 
When you finish working in Windows, use the Shut Down command on the Start 
menu. This command closes windows and programs and prepares your 
computer for shutting down. If you haven't already saved your work, you're 
prompted to do so. 
 
Important - Don't turn off your computer until you see a message that the 
computer has been shut down. If you turn off your computer without shutting it 
down correctly, you risk losing information. 
 
To shut down your computer 

1. Click the Start button, and then click Shut Down.  
2. Select Shut down, and then click OK.  

 
If your computer doesn't turn off automatically, a message appears after a few 
moments telling you when you can safely turn off your computer. 
 
F. Health and Safety 
Before starting working at a computer you should: 
 Adjust the positions of the screen, the keyboard, the mouse and the 

documents you're working from, so as to achieve the most comfortable 
arrangement.  Make sure that you have space to use your mouse easily, and 
rest your wrists in front of the keyboard when not typing. 

 Adjust the position of your chair to give you a comfortable viewing distance 
and posture.  The screen should probably be somewhere between eighteen 
and thirty inches away from you, whatever suits you best. 

 Keep your back resting against the back of your chair so that you are not 
leaning towards your monitor. 

 Keep your neck and back in a straight position. 
 Good keyboard and mouse techniques are important.  Keep your upper body 

as relaxed as possible and don't over stretch your wrists and fingers.  As a 
general guide, your forearms should be roughly horizontal and your elbows 
level with the keyboard or the mouse. 

 If your feet don't reach the floor when you're sitting in a good position, try a 
footrest. 

 Use a document holder when copying from a manuscript.  
 
Whenever you can, try to arrange your study to consist of a combination of work 
on and away from the screen, to prevent fatigue and to vary visual and mental 
demands.  Long spells of screen work should be broken up by periods of work of 
a different kind. 
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The nature of your study and the combination of media you're using will 
determine the length of breaks you need to prevent fatigue, but as a general rule: 
 You should take breaks before the onset of fatigue, not in order to recuperate. 

The timing of the break is more important than its length. 
 Short, frequent breaks are more satisfactory than occasional, longer breaks. 

A break of thirty seconds to two minutes after twenty or thirty minutes of 
continuous work with the screen and keyboard is likely to be more effective 
than a fifteen-minute break every two hours. 

 If possible, you should take your breaks away from the screen, and avoid 
activities that require actions similar to your work (writing, crosswords or 
needlework, for example).  

 

G. Accessibility for Persons with Disabilities 
Windows includes many accessibility features that can improve display, sound, 
mouse, and keyboard settings for users with disabilities.  These are available 
through the “Accessibility Options" located in the Windows Control Panel to 
directly customize keyboard, display, and mouse functions. 
 
 
 
Exploration: Go to a computer workstation and identify each of the components 
reviewed above.  How does the computer look different from how you pictured it 
from the descriptions above?  How should the descriptions be changed?    
 
After you complete this exploration you are ready to proceed to the next section 
of this Orientation.   
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V. Using a Mouse 

 
 
A. Introduction 
This part of the orientation will introduce some basics about using a mouse for 
people who are not that familiar with using a computer mouse.  The mouse 
usually sits on the desk beside your computer console. When you move your 
mouse it sends a signal through the cord to the computer, telling the computer 
which direction the mouse is moving. This controls the movement of the small 
arrow (mouse cursor) on the screen.  
 
Depending on the mouse you have, there may be a combination of buttons and 
knobs on the top of the mouse. Some may have two buttons on the top of the 
mouse and some may have three buttons. A mouse makes a clicking noise when 
you push the buttons. A mouse generally sits with the buttons away from you. It 
is designed to sit underneath your hand with your fingers on the buttons.   
 
The mouse can sit to the left or to the right of the computer console, depending 
on if you are right handed or left handed (however, some computer system 
settings changes will have to be made if you are not using the right handed 
default setting).  
 
 
B. Mouse Functions 
You can manipulate the mouse by holding your hand over the mouse with the 
palm of your hand on the large base part of the mouse and holding your index 
finger up and over the inner mouse button. The button under the index finger is 
always the button you will use the most for your mouse.  There are four basic 
functions you can perform with your mouse: pointing, clicking, double clicking 
and dragging.  
 
Pointing is when you move the mouse in order to move the arrow/cursor on the 
screen to a desired location (i.e., to a program icon).  Often, when you hold the 
mouse over an image or icon information will come up on screen about the 
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object/program.  Please note that if you run out of room on your desk and cannot 
move your mouse any further to the right or left, simply pick up the mouse and 
physically move it back to a location where you have room to move it and 
manipulate it. Often, there will be a mouse pad on which to move your mouse. 
This pad helps to keep the bottom of the mouse clean from dust and dirt. It helps 
to maintain the life of the mouse, but is not necessary for it to work. 
 
Clicking is accomplished by first pointing to a desired object and then pressing 
and releasing the mouse button positioned under your index finger. Simply 
speaking, a click is when you press down on the mouse button and then release 
the button (usually the left button). Single clicking with the mouse button at the 
opposite end of the mouse will bring up a pop up menu of options.  
 
Double-clicking is accomplished by first pointing at an object with the mouse 
and then quickly clicking twice in succession on the desired object. A double-click 
consists of two quick clicks (on the same spot) of the mouse button.  This action 
takes a little bit more dexterity to be able to complete a double click, and if you 
don’t complete the double clicks fast enough the computer will just sit there, and 
not complete the action you are asking it to perform.  
 
Dragging happens when you point to an object and then press and hold down 
the mouse button under your index finger. After you have the desired object (i.e., 
file, folder, text) selected, you can slide the object to the new desired location by 
moving the mouse (while still keeping the mouse button clicked) and then 
releasing the mouse button once the object is in the desired location. This "drag 
and drop" functionality makes using a mouse extremely convenient.  
 
Please note: If you do “drag and drop” - if the material is not your own, 
remember that appropriate referencing where the material came from is 
incredibly important! 
 
 
Exploration:  Become more familiar with using a computer mouse by going to a 
computer work station and trying each of the actions outlined above.   
 
After you complete this exploration you are ready to proceed to the next section 
of this Orientation.   
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VI. The Internet 
 
A. Introduction  
This part of the orientation will cover a bit of background about the Internet, 
Internet connections, web browsers, navigation program, saving a file, retrieving 
a file and doing basic editing.   
 
The Internet is the world's largest, most powerful computer network connecting 
personal computers, sophisticated mainframes, and high-speed supercomputers 
around the globe.  The Internet started as a military experiment to ensure that 
there were communication avenues in the case of nuclear war.  
 
The World Wide Web (WWW) is an aspect of the Internet that organizes 
information through web pages.  The WWW has the ability to integrate graphics, 
text, and sound into a single tool means so novice users do not have to struggle 
with a steep learning curve. Web pages have made the Internet into an 
environment that is extremely user-friendly.  The interconnected nature of the 
web allows users to dynamically link to desired information. The premise of the 
Internet is that it is uncensored, belonging to everyone, yet belonging to no one 
single person.   
 
 
B. Internet Connection  
From a NSCC Campus location, you will connect to the Internet using the 
College Network.  From other locations, you may need to use a local Internet 
Service Provider (ISP) for your connection.  Once you have your connection, you 
can access the Internet by starting your browser program.  
 
 
C. Browser Programs  
Today, many different software programs or "browsers" are utilized to navigate 
the Internet.  This includes programs such as Netscape Navigator and Microsoft 
Internet Explorer. The Web browser links to the remote computer just long 
enough so that the information you need can be sent to your computer for you to 
view.  Mosaic was the first of the Internet tools that are now referred to as "web 
browsers."  Web browsers have increased useful access to the information 
located on the Internet.    
NSCC has Microsoft software licensing.  This means that Microsoft Explorer is 
used as the basic web browser program on NSCC Campuses.  Usually, you can 
start the browser by double clicking on the program icon on the Windows desktop 
or by single clicking on the Windows “Start” button, and then dragging the cursor 
to "Launch Microsoft Internet Explorer Browser." Internet Explorer usually has a 
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lower case letter “e” icon.  These can be located in a couple of locations, 
illustrated with red arrows in the diagram below.   
 

 
 
Once you initiate the start of the browser program, a splash screen will appear 
while the program is loading. When the browser has finished loading, it will go to 
the default home page for your location (depending on if you are connecting from 
home, from etc.).  At the top of the Internet user interface there is a white location 
bar.  At any time, you may use this location bar to manually type in the address 
or Uniform Resource Locator (also known as U.R.L. or URL) of any web site. 
 
 
D. Search Engines 
Search engines are essentially computer robots that will go out to the Internet 
and search for things that you tell them to.  Figured prominently on most search 
engine web pages are small text fields for you to type in the term or terms for 
which you are searching.  There are many different search engines that are 
available today, each of which has their own strengths and weaknesses.  You will 
need to try out some for yourself and decide which ones you like and why.   
 
To start you can try:  
Google at http://www.google.ca/
Lycos at http://www.lycos.ca/
Alta Vista at http://www.altavista.com/
Ask Jeeves at http://www.ask.com/
 
  
E. Navigation Tips 
Navigating on the Internet is pretty straight forward.  However, here are some 
basic traffic rules to get you started: 
 

http://www.google.ca/
http://www.lycos.ca/
http://www.altavista.com/
http://www.ask.com/
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1. On web pages you will likely see a number of blue underlined terms phrases 
or URL addresses. You may single click with the mouse on these "links" to 
take you to other pages. 

 
2. On web pages, some icons may be links as well.  These icons will change the 

usual "arrow" cursor of the mouse into a finger pointing.  This indicates that 
the icon is also a link, which leads to something else, somewhere else.  If you 
single click with the mouse on the linked icon, it will take you to the address of 
that link.   

 
3. You can also navigate the web by using the gray tool bar near the top of the 

browser page.  You can use "BACK" and "FORWARD" to move to previously 
visited pages.  Right clicking with the mouse on the Internet page can 
accomplish the same navigation functions from the pop-up list that appears.   

 
4. Nova Scotia Community College has its own web site.  The address of the 

NSCC web site is: http://www.nscc.ca   
 
 
 
Exploration: Use Internet Explorer as your browser to go to the Internet.  Visit 
NSCC’s web site and see what information you are able to find out about a 
program of interest to you.   
 
Try using one of the search engines available to conduct an online search using 
"online learning" as your key search terms.  Explore some of the sites that you 
find.    
 
After you complete this exploration you are ready to proceed to the next section 
of this Orientation.   
 
  
 

http://www.nscc.ca/
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VII. Word Processing 
 
A. Introduction 
Word processing has changed the way that many documents are produced.  In 
the past, where the typewriter might have been used to generate single typed 
copies of documents, word processing now allows electronic copies of 
documents to be created, saved, stored and subsequently updated, edited, 
changed  and used again in other ways.  The NSCC has Microsoft software 
licensing.  This means that Microsoft Word is used as the basic Word processing 
program on NSCC Campuses.  This part of the course will cover the basic steps 
for starting a word processing program, saving a file, retrieving a file and doing 
basic editing.   
 
 
B. Starting The Program 
To start Microsoft Word, you can double click on the program icon on the 
Windows desktop.  The icon for Word is usually a large letter "W."  If there is no 
program icon, then you will have to single click on the Windows "start" button, 
drag the mouse up to "Programs" and then select Microsoft Word from the pop-
up list of options.   
 
 
C. The User Interface  
The User Interface is a fancy way of saying "what you see on the screen and 
how you use it."  When you start Word, the program will open up a new blank file.  
Something like "Document 1" will display at the top of the Window.  The screen 
will look something like the one pictured below.   
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The Title Bar 
At the top of the screen is the Title Bar, which tells you the name of the program 
you are using and the name of the document currently open on the screen.  On 
the right hand side of the Title Bar are three buttons.  The left-hand button (the 
horizontal line) is the minimize button.  Clicking on this button will cause Word to 
be minimized to a button on the taskbar.  The button in the middle is the 
restore/maximize button the change the size of the window.  The far right-hand 
button with the "X" is the close button: clicking this will exit from Word.  
 

The Menubar 
Below the Title Bar is the Menu Bar. 
 

 
 
This holds all the pull-down menus for Word. To see the menus, click with the left 
mouse button on the menu required.  When a pull-down menu is displayed it will 
have several options that can be selected by clicking on them with the left mouse 
button.  To close a menu without choosing a command, click on a blank area of 
the screen.  Any options displayed in light gray are currently unavailable but may 
become available at a later time.  For example, you will not be able to use Copy 
from the Edit menu unless you have already selected the text you want to copy. 
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Toolbars 
Immediately below the menu bar are one or more rows of tools.  The commands 
you need to perform most of the basic operations in Word can be found in these 
tool buttons.  By single clicking one of the tool buttons you can activate many 
different commands (i.e., save, print).  Some options on the toolbars are in the 
form of pull-down lists  (i.e., font, font size). 
 
The standard & formatting toolbars look like this: 

 

 
 
Move the mouse pointer over each of the buttons on the toolbar (but don’t click 
on them).  A short description pops up to tell you what each button will do.  All 
the commands found on the toolbars can also be found under each menu.   
 
A toolbar button, which looks “pushed in” means that option, is currently active.  
Clicking it again will turn it off.  If you need any information about what a 
particular command will do, or want to know more about performing certain tasks, 
then Word has a good on-line help system. To access this, either select a 
command from the Help menu, or click on the Office Assistant icon. 
 

The Ruler 
Below the toolbars, there may be a ruler displayed.  It looks something like this:  

 
 
This displays current margins, tabs and indent settings. 
 

The Status Bar 
At the bottom of the screen is the status bar. 

 
 
This displays information about your document, including: Page number, Section 
number, the total number of pages from the beginning of the document followed 
by the total number of pages in the whole document, the position of the cursor 
from the top of the page, the line number and column number. 
 
 
D. Using the Program 
If you start typing something on the blank screen that appears below all the 
toolbar options, this will be the start of your word processing file. You will see 
how much better word processing is than typing once you start creating a 
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document.  As you type, you can easily edit what you have typed by moving the 
mouse around, repositioning in the document and changing how you have 
worded something.  Word automatically wraps the lines of text to fit between the 
margins of the page as you type, starting a new line when needed. If you add or 
delete text, change the margins, or change the format of your text, Word 
automatically adjusts the position of the text for you. Unlike using a typewriter, 
you only need to press Enter key at the end of each paragraph.  
 

Correcting Mistakes 
If you make a mistake when typing you can delete the character to the left of your 
cursor by pressing the Backspace key. You can delete the character to the right 
of your cursor by pressing the Delete key. 
 

Capital Letters 
For single capital letters hold down Shift key and press the letter. For all capital 
letters press the Caps Lock key. 
 

Undo 
This button on the toolbar allows you to undo a particular command or action. If 
you don't like the results of a command or accidentally delete some text, choose 
Undo as your next action. This command is also available in the Edit menu.  
 

Redo 
The Redo button works in the same way as the undo except you can redo an 
undo command.  This command is also available in the Edit menu. 
 
Formatting Text 
Once your document has been typed, it can be enhanced with effects such as 
bold, underline, different fonts and centering.  For new text, you can switch these 
options on, type the text, and then switch the option off again. However, if you 
want to alter text you have already typed, you must select it first. 
 
Selecting Text 
To select text, do this: 
Move the mouse cursor to the start of the text you want to select; click and hold 
down your left mouse then drag the cursor across the area to be selected.  The 
text will be highlighted as you drag the cursor across it.   
 
Bold, Underline and Italics 
Select the text you want to format then click the Bold, Italic or Underline button. 
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Text Alignment 
The same steps are repeated when aligning text on the screen.  The two icons 
displayed shows text being left aligned (Align Left), and text being centered 
between the margins (Center).  To make the text flush to the right margin (Align 
Right), and aligning to both margins (Justify), use the pull-down menu for more 
options. 

 
 
Fonts and Sizes 
The different typefaces used in word-processing documents are known as fonts.    
Fonts are usually measured in points.  A point is 1/72 of an inch.  Standard text is 
usually Times New Roman in 10pt size.  Font types and sizes can be selected 
before typing text or can be added retrospectively to specific sections of text (by 
selecting the text first).  To select font types and sizes from the formatting 
toolbar, click on the arrow next to the current font name and a list of available 
fonts will be displayed.  The pull-down list below lets you choose the font size. 

 
 
 
Copy and Paste 
You can use some of the fancy mouse skills that you acquired in order to 
highlight, copy and paste selections you have written from one location to 
another.  Copying and Pasting is a way of moving sections of text or copying 
things into your document. It is available in all Windows applications, and you 
can use it to copy things between different applications. There are two 
commands involved: Copy and Paste. Each can be selected from the EDIT menu 
or from buttons on the standard toolbar. 
 
When you copy text, it is put into an area known as the clipboard, which is 
available to all Windows programs. Copy simply puts a copy into the clipboard. 
The Paste command copies whatever is in the clipboard into the document at the 
current cursor position. If text is selected when you paste from the clipboard, its 
contents replace the selected text. Text remains in the clipboard until the next 
Copy, so you can paste the contents of the clipboard several times.  You can 
paste between Windows applications. For example, you can insert a picture into 
a document by copying it from Paintbrush and pasting it into Word. 
 
Cut 
The Cut command is another way of moving sections of text.  Unlike the Copy 
command, Cut deletes the text from the document and puts the text into the 
clipboard.  You can then use the Paste command to insert the information 
elsewhere.  
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Drag and Drop 
Select a block of text to be moved and place the mouse pointer over the text.  
Hold down the left mouse button and DRAG the pointer to the new location for 
the text. 
 
A gray vertical line will indicate where the text will appear in the document.  
Release the left mouse button and DROP the text into its new location.  Dragging 
and dropping is a quick alternative to Cut and Paste but can be a little tricky to 
control if you are new to using a mouse. 
 
Spell Checking 
Word has a built-in dictionary, which can be used to check the spelling in your 
work.  Word also checks for repeated words (the the), odd capitalization (tHE), 
and proper nouns (london). 
 
To spell check a document select the word or section of the document you want 
to check.  If nothing is selected, Word checks the document from where the 
cursor is, and when it reaches the end will ask if you want to continue from the 
beginning, until it has checked the whole document. 
 
Select Spelling and Grammar… from the Tools menu.  Word looks for words in 
your document that don't match those in its dictionary.  It highlights those words 
and displays the Spelling dialog box. 
 
To correct the misspelled word, either type it in the text area or select the correct 
word from the Suggestions list.   
 
Press the Change button to replace the misspelled word with the correct one, or 
press Change All to change all occurrences of the misspelled word in your 
document.  If the word highlighted is spelt the way you want, choose Ignore to 
leave the word as it is, or choose Ignore All to ignore all occurrences of this word 
in your document.  If Word highlights a word it does not recognize and you know 
that it is spelt correctly, you can add the word to the dictionary by selecting Add.   
The word is added to the dictionary displayed in the Add box.  Word continues 
checking your document.  Choose Cancel at any time to stop the spell check. 
 

Thesaurus 
When you're not sure of the meaning of a word, or when you think you're using a 
particular word too often, use the Thesaurus.  It defines selected words and 
offers alternatives (synonyms). To use it: 
 Select a word in your document then select Tools, Language, and Thesaurus 

from the menu bar. 
 The Thesaurus dialog box appears, showing the meaning of the word on the 

left and a list of synonyms on the right. 
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 To see a list of other related words click on any related words in the meaning 
box. 

 To choose an alternative, highlight it and then click REPLACE. 
 

Word Count 
Select Tools/Word Count. 
 Check the number of words in the document 
 Save the file. 

  
 
E. Saving Your Work 
You should save your document regularly as you are working on it, not just at the 
end.   
 
To save a new document for the first time.   
 Select Save from the File menu, or click on the save icon on the Toolbar. You 

will see a dialog box similar to the one below: 
 

 
 
Check the Save in: box to see where your file is being saved. The default on 
most PCs is the "My Documents" folder.  You can now give your document a file 
name.  Word will suggest a name in the File Name: box. You can accept this, edit 
it, or replace it with a name of your choice.  
 Then click Save. 
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Filenames 
File names can be up to 255 characters long but cannot include special 
characters such as:  
 
forward slash (/) 
backslash (\) 
greater than sign (>) 
less than sign (<) 
asterisk (*) 
period (.) 
question mark (?) 
quotation mark (") 
pipe symbol (|) 
colon (:) 
or semicolon (;) 
 
When saving a file, Word will automatically give each filename the extension 
.DOC to enable Word to recognize its own files.  

Once you have named a file and saved it, you can save other changes you make 
by simply single clicking the "save" button: your existing document will be 
updated.   

 
Opening Files 
To open an existing document  
 Select Open... from the File menu or click on the open icon on the toolbar.  

Both actions will present you with a dialog box like this:  
 Find the file you want to open click on it and then click Open. 

 
As you are discovering, word processing gives you all kinds of options for 
creating and communicating information.   
 
 
 
Exploration: Create a brief biography explaining who you are and a little bit 
about yourself.  Only share what you would be comfortable sharing with a group.   
 
After you complete this exploration you are ready to proceed to the next section 
of this Orientation.   
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VIII. General Troubleshooting Strategies 
 
It is important to remember that computers are just machines. They crash, 
perform illegal operations and can be extremely frustrating at times.  This section 
details some very general strategies for coping with computers and technical 
problems.  
 
Remember that technical support comes in a number of different shapes and 
sizes. Look around yourself and utilize the expertise of those people around you. 
You never know who might be able to lend a hand. As well, there is always 
access to help and assistance through the various programs and their associated 
help files. Do not be afraid to utilize this information: it may have just the answer 
you were looking for.  As well, each computer program has tits own built-in help 
function.  Do not hesitate to take advantage of the system help available from 
within the program you are using.   
 
Every now and then your computer will lock and you won’t be able to do 
anything. This can happen even when you’ve done nothing wrong. To rectify the 
situation you can hold down the Ctrl, Alt, and Del keys at the same time. The 
computer will give you the opportunity to end the task you were using before the 
computer locked up. Once you end this task you can usually resume from where 
you left off.  NOTE: Closing the program or restarting the computer will erase all 
data that hasn’t been saved. 
 
Strategy: If you hold down Ctrl, Alt and Delete three immediately successive 
times it will restart your computer. 
 
A good rule of thumb is that if your computer starts doing things that seem 
strange or somehow out of the ordinary, a restart may be in order. If your 
computer encounters some sort of an internal error it may keep working for a 
while, but things may continue to go wrong.  
 
Strategy: Try restarting the computer by clicking on the Start button, selecting 
the "shut down" option and then choosing the "restart" radio button option.  
 
If your computer freezes up, will not restart using Ctrl, Alt and Delete and will not 
restart using the normal procedure, you may need to take more drastic action. 
The reset button (or On/Off switch) is a panic button, but only use it when nothing 
else (even Ctrl, Alt, Delete) works. When you press the button you are destroying 
all the work you haven’t saved during the day. Some computers have a reset 
button and a main power switch; others just have a single switch. Use the 
strategy that works with your computer. 
 
Strategy: Use the reset button when nothing else seems to work for re-starting 
and resetting your computer.  
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It is important that you have somewhere you can call to talk to someone if you 
are having continuing difficulty. Anywhere in the content modules of the course 
where you see a "help" button with the image of the question mark, it means that 
you can use that link to view (and print if you like) the associated help contact 
information of the module.  
 
Remember: Your first avenue for assistance if you are experiencing difficulties is 
course instructor. For additional technical assistance, please contact the NSCC 
Online Learning Offices. If you are unable to connect with a person right away, 
always be sure to leave a detailed message.  
 
 
 

IX. Getting Help  
 
As a learner taking an online course, your learning may be challenged in new 
ways.  Please, do not hesitate to initiate contact if you have questions:  
 
Remember that your instructor is your contact for course content questions.   
 
For technical concerns, please do not hesitate to contact NSCC Online Learning:  
 

 Phone: (902) 491-6774  
 Toll Free: 1-877-491-6774 
 Fax: (902) 491-4835 
 Email: online.learning@nscc.ca  

 
All the best with your course! 
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